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Preface

Intended Audience
Welcome to Release 11i of the Oracle Sales Offline User Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Sales Offline

� Oracle Field Sales (formerly known as Oracle Sales Online)

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Sales Offline.

� Chapter 1 provides an introduction to Oracle Sales Offline.

� Chapter 2 provides information on creating and updating a task.

� Chapter 3 provides information on creating and updating leads.

� Chapter 4 provides information on creating and updating opportunities.

� Chapter 5 provides information on creating and updating quotes.
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� Chapter 6 provides information on creating and updating forecasts.

� Chapter 7 provides information on creating and updating customers.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Sales Offline.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.
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Related Documentation
Oracle Sales Offline shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Sales Offline.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Sales Offline (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Sales Offline Implementation Guide
This guide provides how to implement and manage Oracle Sales Offline. 

Oracle Field Sales User’s Guide
This guide explains Oracle Field Sales, an HTML-based applications that provides 
sales managers, sales representatives, and sales executives with assistance in 
managing their business opportunities, customer, forecasting, incentive 
compensation, partners, and quotes. 

Oracle Quoting User Guide
This guide explains how to use Oracle Quoting to create and manage customer 
quotes across all sales and interaction channels. Oracle Quoting is used to propose 
product solutions and perform negotiations, while enforcing consistent business 
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rules throughout the sales cycle. Users can publish and print quotes, and eventually 
convert quotes to orders. 

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.
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Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Sales Offline. This 
manual details additional steps and setup considerations for implementing Oracle 
Sales Offline with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Sales Offline with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Sales 
Offline.
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Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Sales Offline implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.
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Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Sales Offline 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University's online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Sales Offline working 
for you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
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download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
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modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction to Oracle Sale Offline

This chapter discusses the key features and process flows of Oracle Sale Offline. 
Sections in this chapter include:

� Section 1.1, "Overview"

� Section 1.2, "Sales Offline Prerequisites"

� Section 1.3, "Oracle Sale Offline Key Features"

� Section 1.4, "Oracle Sale Offline Integrations"

� Section 1.5, "Accessing Oracle Sale Offline"

� Section 1.6, "Navigating within Sales Offline"

� Section 1.7, "Setting Synchronization Preferences"

� Section 1.8, "Synchronizing Data"

� Section 1.9, "Conflict Resolution"

� Section 1.10, "Timing Log"

� Section 1.11, "Version Identification in Sales Offline"

� Section 1.12, "Status Bar Messages"

� Section 1.13, "Common Tabs"

1.1 Overview
Oracle Sales Offline give you the information you need to manage your sales efforts 
while you are on the road. You can access detailed customer information, product 
interests, and notes about customers. Contact information allows sales 
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Overview
representatives to identify key players within their accounts and share that 
information with other members of the sales team. 

Sales Offline is a mobile application that imports and exports (synchronizes) 
information from an Oracle enterprise database, and enables you to view and/or 
update your sales information remotely via your laptop computer. You can add, 
view and edit customers, opportunities, leads, quotes, and forecasts right from your 
laptop, saving the changes for upload later. 

Your sales organization can optimize their selling time in the field by having key 
customer information readily available. This enhances your relationships with 
customers and promotes company profitability. Oracle Sales Offline integrates with 
the Oracle Sales applications, and is designed to maximize sales effectiveness in the 
mobile environment. Oracle Sales Offline is part of the Oracle E-Business Suite, an 
integrated set of applications that are engineered to work together.

Simple, Effective Design for Sales and Support Organizations
Oracle Sales Offline offers sales organizations the functionality required in an 
interface that is both familiar and effective. Leveraging the capabilities of desktop 
applications, Oracle has designed a template that provides sales organizations a 
way to manage sales information without the need to install additional software. 
The template is easily downloaded from Oracle Field Sales and provides 
upload/download data capabilities. Oracle Sales Offline provides you with the 
ability to view and edit sales information, while your support organization does not 
have to support any additional technical software on the laptops.

True Team Selling
To manage and close deals successfully, sales teams often cross group boundaries, 
territories and even company lines. Oracle Sales Offline works with Oracle Field 
Sales and Oracle Telesales to create a virtual sales team that enables the sharing of 
opportunities, contacts, notes, and other pertinent customer information between 
sales team members. Opportunities can be automatically or manually assigned to 
sales members. Sales representatives are able to see valuable information from 
partners about their accounts as they prepare for on site meetings. Oracle's sales 
automation modules complement each other and provide the perfect solution for 
team selling in a dynamic selling environment. 

Access to Sales Information
Oracle Sales Offline gives you the information you need to manage your sales 
efforts when you are on the road. You can access detailed customer information, 
product interests, and notes about the customers. Contact information lets 
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Oracle Sale Offline Key Features
representatives identify key players within their accounts and share that 
information with other members of the sales team.

1.2 Sales Offline Prerequisites
These are the prerequisites for Oracle Sales Offline:

Oracle Applications
� Oracle Field Sales, minimum version required is 11.5.7 (also known as Oracle 

Sales Online)

� Oracle Quoting, minimum version required is 11.5.7 (if you will be using offline 
quoting)

� Oracle Web Applications Desktop Integrator

Desktop Requirements
� Windows 95/NT/2000 operating system

� Microsoft Excel 2000

� Licensed copy of WinZip

Desktop Recommendations
� 500 mHz or higher processor

� 256 mb RAM or higher

1.3 Oracle Sale Offline Key Features
Oracle Sale Offline includes the following features:

� Lead Management

� Opportunity Management

� Sales Forecasting

� Offline Quoting

� Task Management

� Flexfield Support

� Home Tab - New Items and Conflict Resolution
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� Incremental Synchronization

� Sync Preferences Filters

Lead Management
You can manage leads and qualify them into sales opportunities. Leads can be 
prioritized so that you can target activities on hot leads first. Oracle Sales Offline 
gives you access to lead information such as notes history, key contact, and product 
interests. All changes to the lead can be synchronized back to the enterprise 
database. Also, you can perform the lead to opportunity business flow in Sales 
Offline.

Opportunity Management
You can manage opportunities remotely through the sales cycle. Oracle Sales Offline 
gives you access to opportunity activities and statuses, notes history, key contacts 
and sales credits. You can create and update the opportunity information by adding 
new notes, changing the opportunity status, and adding product interests. Access to 
this information and the ability to update it enables sales organizations to sell more 
effectively. Sales team members can share information about call activity, major 
issues, and account strategy. All changes to the opportunity can be synchronized 
back to the enterprise database. Also, you can perform the opportunity to quote 
business flow in Sales Offline.

Sales Forecasting
Oracle Sales Offline enables you to build forecasts constructed from opportunities. 
Sales forecasts can be updated on the road, and forecast commitments can be 
synchronized back to the enterprise database to be viewed by sales managers.

Offline Quoting
Oracle Sales Offline supports mobile quoting functionality. The quoting module 
allows you to maintain and develop customer quotes. You can view detailed quote 
information, such as customer account information, contact details, and ship-to and 
bill-to information. Products can be added, removed, and priced using offline 
quoting. Manual price adjustments can be placed at the product line level. All 
changes to the quote can be synchronized back to the enterprise database. You can 
generate quotes to view and edit at a customer site. 

Task Management
Sales Offline supports task management features. You can download tasks that are 
assigned to you, or that you own. These tasks can be viewed and edited in Sales 
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Oracle Sale Offline Integrations
Offline, and you also have the ability to create new tasks. Tasks can be stand-alone, 
or associated to an Oracle business object. You have the ability to display tasks for a 
particular day or date range in Sales Offline using the Daily Task summary form.   

Flexfield Support
Sales Offline supports customer defined flexfields, where applicable. Flexfields 
established in the online sales applications can be downloaded for use in Sales 
Offline. You can add, view, and edit data captured in these flexfields, and have the 
data synchronized to and from the Online sales applications. 

Home Tab - New Items and Conflict Resolution
The Home Tab of Oracle Sales Offline is the first window you see in the application, 
and lists newly added or changed records during the last synchronization. Initially, 
the Home tab will not list any records. New or changed items are listed as the result 
of subsequent synchronizations. Records are listed in the various tables, depending 
on the source of the record.

The Conflict Resolution subtab is available in the Home Tab. The conflict resolution 
sheet displays conflicted records that occurred during synchronization, and 
provides a side-by-side comparison of the local client record and the associated 
server record. You can reapply or discard the conflict records directly through Sales 
Offline.

Incremental Synchronization
Sales Offline supports incremental synchronization for uploading and downloading 
sales data. After the initial install, only the records that have been changed or added 
in Sales Offline are uploaded during synchronization, and only the records that 
have been added or changed in the online applications are downloaded.

Sync Preferences Filters
The Synchronization Preferences allows you to selectively download sales data. The 
synchronization preferences user form allows you to filter data based upon Oracle 
business objects, such as, organizations, leads and opportunities. These selective 
download options can be saved and edited. 

1.4 Oracle Sale Offline Integrations
Oracle Sale Offline integrates with the following modules:

� Oracle Field Sales
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Accessing Oracle Sale Offline
� Oracle Quoting

Oracle Field Sales
Oracle Field Sales is an application designed for field sales representatives, sales 
managers, and executives. This application provides a complete set of tools that 
enables sales teams to manage the sales cycle from beginning to end. 

Oracle Quoting
 Oracle Quoting is used to propose product solutions and perform negotiations, 
while enforcing consistent business rules throughout the sales cycle. Users can 
publish and print quotes, and eventually convert quotes to orders. This integration 
applies only if offline quoting is used in Sales Offline.

1.5 Accessing Oracle Sale Offline
Sales Offline is available from the Mobile tab in Field Sales, in the form of a 
compressed file.

Reference
Oracle Sales Offline Implementation Guide

Login
Log in to Oracle Applications to access Field Sales.

Responsibility
Sales Online Administrator

Navigation
Mobile > Download Sales Offline Template 

Steps
If you are a first-time-user, you must download Sales Offline from Oracle Field Sales 
before proceeding.

To download Sales Offline:

1. Login to Oracle Field Sales.

2. Click the Mobile tab. 
1-6 Oracle Sales Offline User Guide                        



Accessing Oracle Sale Offline
3. Create a new folder in your directory.

4. Download Sales Offline by clicking the Download Sales Offline Template link. 

5. Navigate to the downloaded file SalesOffline.zip in your directory. 

6. Unzip the file into your folder.

7. Run Sales Offline by double-clicking the file SalesOffline.xls.   

8. Enable macros when prompted. If Sales Offline fails to open when you choose 
to enable the macros, check to ensure that the macros security is set to the 
medium or low level. You can do this by navigating to Tools > Macro > Security 
in Excel 2000. 

9. Click the Sync icon.

10. Enter the requested user information and then click Sync. The synchronization 
preferences will display the first time you Sync.

11. Enter the download criteria by choosing the Territory Driven Download, Sales 
Team Driven Download, or Forecast Driven Download. 

You can filter your data using the Sync preference filters associated with the 
downloads. See Setting Synchronization Preferences for details. These 
preferences can be saved for use in future synchronizations. 

These are the Sync preference filters which are applicable to Territory Driven 
and Sales Team Driven downloads:

� Lead Preferences - can be filtered by Status, Channel, Lead Rank, Budget 
Status, Time Frame, or Number of Records

� Opportunity Preferences - can be filtered by Status, Sales Stage, Sales 
Channel, or Win Probability (from/to)

� Quote Preferences - can be filtered by Inventory Category Set (Default 
Category Set, or the Sales and Marketing Category Set), Inventory Category, 
or Price List

You must select items (from the Default Category Set, the Sales and 
Marketing Category Set, or the Price List) for download. You can select 
items from multiple categories. Multiple items can be selected by 
highlighting a row and using the Ctrl or Shift functions.

Note:  Not all synchronization preferences filters are applicable to 
the Territory Driven Download. 
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� Forecast Preferences - can be filtered by Period Type, Category, Start Period 
and End Period, or Credit Type

� Customer Preferences - can be filtered by Customer Category, or Country

1.5.1 Territory Driven Download
The Territory Driven download provides added efficiencies on top of the Sales Team 
Driven download by allowing the user to limit the address and contact data which 
is downloaded to that which is in their sales territory. This is of benefit in that the 
user is able to download a smaller quantity of data, which is more relevant to their 
day to day sales activities. Sales territories are typically established using Territory 
Manager, and manual Territory Location assignment can also be performed in Sales 
Online.

The Territory Driven Download accounts for only the address-specific qualifiers, 
such as postal code. It does not take into account territory qualifiers, such as named 
accounts. If you use the Oracle Territory Manager assignment process, the territory 
address qualifiers must be established before this synchronization option can be 
used effectively. You can also manually assign a sales user to a certain Oracle 
business object. Manual assignments will also be synchronized by Sales Offline 
using the Territory Driven Download.

Only addresses associated to the sales user’s territory are available under an 
Organization or Person. Users may not be able to download or view all addresses 
associated to an Organization or Person. 

This is how the Territory Driven downloads affect Oracle business objects available 
in Sales Offline:

Organization and Persons: The Territory Driven Download will download only 
Customers, which have an address that resides within a sales representatives 
established sales territory via an established address qualifier. The Territory Driven 
Download will download only Contacts related to an Organization, which have an 
address that resides within a sales representatives established sales territory. 
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Opportunity: If a Sales Offline user is on the sales team (automatically assigned via 
territory or manually assigned) for an Opportunity, the Opportunity is 
synchronized to Sales Offline. 

Lead: If a mobile sales user is on the sales team (automatically assigned via territory 
or manually assigned) for a Lead, the Lead is synchronized to Sales Offline. 

The Territory Driven Download does not affect the Task or Quote synchronization 
method. If a user is on the sales team of a Quote (regardless of Territory 
information), the Quote is synchronized to Sale Offline. If a user owns or is assigned 
a Task, the Task is synchronized to Sales Offline. 

1.5.2 Sales Team Driven Download
The Sales Team Driven download will result in records based on your sales 
team access. If you are on the sales team of an Oracle business object (for 
example, organization, lead, or opportunity) these records are downloaded to 
Sales Offline. 

1.5.3 Forecast Driven Download
The Forecast Driven download of data is based on the opportunities that are 
open within the forecast range selected. Customer organizations and contacts 
that are associated with the opportunities are downloaded. 

Note: Only Opportunity contacts which reside in the mobile sales 
users territory are downloaded with the Opportunity. Contacts, 
associated to the Opportunity, that do not have addresses 
associated with the mobile sales users territory will not get 
downloaded or viewed in Sales Offline. 

Note:  Only Lead contacts which reside in the mobile sales users 
established territory are downloaded with the Lead. Contacts, 
associated to the Lead, that do not have addresses associated with 
the mobile sales users territory will not get downloaded or viewed 
in Sales Offline. 
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1.6 Navigating within Sales Offline
In Sales Offline, tabs indicate the first layer of information and subtabs show further 
details. Links enable you to access detailed information about specific items.

The following table describes navigation features and fields:

1.7 Setting Synchronization Preferences
Sales Offline enables you to select preferences for synchronization. These 
preferences apply to the data downloaded from Field Sales. During the first time 
synchronization, Sales Offline will by default do a full download of necessary data. 
Using preferences to select subsets of data to download can save download time 
and contribute to improved application performance.   You can modify these 
preferences after making your initial choices.

Steps
1. In Sales Offline, click the Profile icon.

2. Make your synchronization selection.

Table 1–1 Navigation in Sales Offline 

Navigation Feature Description

Tab Enable you to navigate among the areas of 
functionality in the application.

Subtab Enable you to access further functionality under a 
tab.

Link or hyperlink Enable you to navigate to further levels of detail 
under the subtab.

Asterisks Designate required fields. These fields have a 
white background. Fields with a white background 
and no asterisk are optional. Fields with a grey 
background are read-only. 

Column headings Enable you to sort rows of information. Clicking 
on a column heading will sort rows in ascending or 
descending order based on the information in the 
selected column.

Go button Enables searches for a list of values. 

Ctrl F Enables you to search for a specific value.
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3. Click Save to save changes or Sync to start the synchronization process (which 
will save changes on completion).

1.8 Synchronizing Data
The Sales Offline synchronization process uploads changes or additions to the 
server and downloads changed or added records back to Sales Offline on your 
laptop. You do not have to login to Oracle Field Sales to upload and download data. 
The synchronization function handles this process within the application. See 
Setting Synchronization Preferences for details on changing data synchronization 
preferences for your data downloads.

Steps
To synchronize data:

1. In Sales Offline, click the Sync icon.

2. The Sync Login window appears. Enter your user name and password. 

3. Click OK. The Sync Console appears. A status bar shows the progress of the 
synchronization. While the synchronization is in progress, you can:

� Go Offline - Click to go offline while synchronization is in progress. This 
enables you to use Sales Offline in a read-only (locked) mode while 
synchronization halts in the background. No changes that you make while 
Sales Offline is in locked mode are saved. Data synchronization must 
complete before you can create, modify, or save data in Sales Offline. 

If you click the Sync button, or attempt to save data while the 
synchronization is offline in locked mode, you will see this message:

Sync and Save disabled while in locked mode.

Note:  Go Offline is not available during some parts of the 
synchronization. For example, you cannot choose Go Offline when 
the synchronization engine is downloading data. 
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This means that the Sync button and the save functionality are disabled 
while Sales Offline is in locked mode. 

To view the progress of the synchronization while in locked mode, close the 
worksheet, and then reopen it. When you reopen it, you will see this 
message:

Do you want to complete the unfinished sync?

and have these choices:

– Yes - continues the synchronization. You will have to provide a login 
password. The Sync Console will appear and display the 
synchronization status bar.

– No - enables you to remain in the offline (locked) mode

� Cancel Sync - Click to cancel the synchronization that is in progress. This 
button is functional at the beginning of the synchronization. As the 
synchronization progresses, you eventually will not be able to cancel, and 
this button is disabled. The Cancel button is disabled when the 
synchronization process is writing to the enterprise database, to protect the 
integrity of the database.

� Show or Hide Details - Click Show to expand the Sync Console and show 
synchronization processing messages. These messages are similar to a log 
file. Click Hide to hide the processing messages. 

4. You will receive a message at the end of the synchronization process informing 
you that the synchronization was successful or if there were conflict errors. 

a. If you receive conflict errors, navigate to the Home tab and click the 
Conflict Resolution subtab to resolve the conflicts in the Conflict Resolution 
screens (see the Conflict Resolution section of the Sales Offline User Guide).

b. If you receive a server not found and not available error, please contact 
your administrator for assistance.

Note: The buttons on the tabs (for example, Task or Lead) are not 
disabled (greyed out) while Sales Offline is in locked mode. 
However the functionality associated with these buttons is 
disabled, so you cannot Create, Save, Cancel, or Apply data while 
Sales Offline is in locked mode.
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5. At the successful end of the synchronization, you will see a message that the 
synchronization is complete, and another message recommending that you save 
your data. Click Yes to save or click No to cancel the save. 

1.9 Conflict Resolution
Using a remote application that synchronizes information with a master database 
can result in data conflicts. Conflict resolution is critical to using a remote 
application successfully, and it is important that up-to-date and accurate 
information is written to the master database. 

It is important to note that the server record will always override your Sales Offline 
client record. If the same server and client record has been changed in between 
synchronization processes, a conflict will occur, and the server record will override 
your client record. The conflict can be resolved in the Home tab, using the Conflict 
Resolution subtab.

Steps
To resolve conflicts between the Oracle Field Sales database and Sales Offline:

1. Open Sales Offline.

2. Click the Conflict Resolution subtab in the Home tab.

3. In the Conflict Resolution screen, you will see tables of conflicts that occurred 
during synchronization. 

4. Click the link to see details of the conflicted record and make the necessary 
updates before deciding to apply the changes or discard them.

On the left side of the form is your local Sales Offline record. On the right side 
of the form is the Oracle Field Sales server record. The fields that caused the 
conflict are shown in red. 

If you choose Reapply, the Sales Offline record will override the Oracle Field 
Sales record. You must perform a synchronization for your record to be applied 
to the database. If you choose Discard, your Sales Offline changes will not be 
applied to the Oracle Field Sales server. If you discard the conflicts you do not 
need to perform a synchronization. 

Note: It is strongly recommended that you save your data after 
the synchronization completes.
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5. From the main Conflict Resolution screen you can select groups of conflicted 
records to Reapply or Discard. Select the checkbox by the record(s) you want to 
reapply or discard. If you want to reapply your changes to the server, click 
Reapply. If you want to discard the conflict, click Discard.

1.9.1 Non-Validated Records (Rejected Records)
You can view rejected records in Sales Offline, as well as a message indicating why 
the record was rejected. Any record that is created in Sales Offline and does not pass 
the online validation rules during the upload-synchronization process is captured in 
a Non-Validated record table in the Home tab of Sales Offline. The non-validated 
records table displays each record that did not pass the server side validation rules, 
the reason why the record did not get applied to the server, and allows you to 
rectify (Reapply, Discard or Cancel) the non-validated record.    

The table contains two columns, Non-Validated Records and Sync Time. The 
Non-Validated Records column contains the record name with hyperlink. The Sync 
Time column contains the server date stamp for the non-validated record's 
synchronization.

The message only appears if non-validated records are listed. The most recent 
non-validated records are listed at the beginning of the table. If a non-validated 
record is a header record, then any accompanying line records are grouped together 
in the table, with the header record listed above the line records.

If the rejected records are related (for example, an opportunity header item and the 
related opportunity lines), then these records are grouped together in the 
non-validated table. If a header record results in a conflict, it is the first item in the 
grouped records, followed by the related line items.

Both rejected header and lines records are listed. Click the identifying text for the 
rejected record and activate the hyperlink that will generate the conflict resolution 
details form. You can read the resulting error message, determine the details of the 
conflict record, and then choose what action to take (either Reapply or Discard) for 
the non-validated conflict record.

If you choose to Reapply a header record
This message will appear:

Are you sure you wish to reapply this record? If you choose to reapply this 
non-validated record, you must perform a synchronization operation for the 
record to be applied to the online server applications. This record, and all it's 
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associated line items, if applicable, will be applied to the online server 
applications.

Click OK or CANCEL. If you choose Cancel, there is no further action.

If you clicked OK, the header record is removed from the non-validated table, a row 
is inserted into the appropriate summary sheet (depending on the source of the 
record), and the record is queued for synchronization.

If the header record has related line records, the associated records will also be 
removed from the non-validated table.

If you choose to Reapply a line record
This message will appear:

In order to reapply this record you must also reapply the header record. 
Please select, and reapply the header record from the Non-Validated records 
table.

Click OK.

The line record will remain in the non-validated table and will only be removed 
when the header record is reapplied or discarded.

If you user choose to Discard a header record
This message will appear:

Are you sure you wish to discard this record? If you choose to discard this 
non-validated record, this record and all its associated line items, if applicable, 
will be removed from Sales Offline. This record will NOT be synchronized to the 
online server applications, and will be removed from Sales Offline.

Click OK or CANCEL.

If you clicked OK, the header record is removed from the non-validated table, no 
row is inserted into any summary sheet, and the record is removed from Sales 
Offline.

If the header record contains related records, then the line records will also be 
removed from the non-validated table, and the related data is removed form Sales 
Offline as well.

If you choose to Discard a line record
This message will appear:
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In order to discard this line level record you must first discard the header 
record. Please select, and discard the header record from the Non-Validated 
Records table. If you choose to do so, both the header record and all its 
associated line records is removed from Sales Offline. 

Click OK.

1.10 Timing Log
Timing functionality has been added to Sales Offline to provide timing statistics for 
these events:

� Opening a file

� Synchronizing data

� Saving a file

These statistics enable administrators to analyze Sales Offline’s performance and 
identify issues that may arise when a large volume of records are processed.

Enabling Detailed Logging

Steps
By default, the timing log is always enabled. You can choose to enable detailed 
logging.

1. Open SalesOffline.xls.

2. Select Oracle > Logging > Detailed 

3. You can also choose Reset to restart the logging, so that the existing log file is 
deleted and a new one begun during your current session. 

4. Exit the template.

5. Reopen the template.

The next time you synchronize your data, Sales Offline will write detailed 
logging information about your synchronization (either full or incremental) or 
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opening or saving a file to the log file. The log file is located in the logs directory 
in the folder containing Sales Offline.  

Logging for a Full or Incremental Synchronization

Steps
The first synchronization of the Sales Offline data is a full synchronization. 
Subsequent synchronizations are incremental.

1. Open SalesOffline.xls.

2. Perform a full synchronization by selecting the Sync button and providing login 
information. 

3. Exit the template. 

4. View the resulting log file in the logs directory in your Sales Offline folder.

1.11 Version Identification in Sales Offline
You can provide support personnel with a unique version number that identifies 
the implemented client version of Sales Offline by navigating to 
Oracle > About Sales Offline. This enables you to identify the version of the client in 
use when you report a Sales Offline problem. 

1.12 Status Bar Messages
Status bar messages display during file open, synchronization, file save, and file 
close, so that the you knows what is occurring on your computer. Status bar 
messaging for phases that relate to the processes of file open, file close, file save and 
synchronization within the Sales Offline client, are displayed to on the Excel status 
bar.

Status bar messages are reported to the user as each processing phase occurs. For 
example, if the phase is 'save contacts', the message 'Saving Contacts' is displayed.

Note: Each time you open the Sales Offline template, the log file is 
copied to a .bak file, and the .log file is cleared. To view the timing 
log, you must look at the log in the logs directory before you open 
the template.
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1.13 Common Tabs
Some tabs are common to several areas in Sales Offline. Rather than describe them 
redundantly in each instance, they are described here. 

Adding Purchase Items

Steps
1. In the window (for example, Create Lead, or Create Opportunity), click the 

Purchase Items tab. 

2. Click Add.

3. Select a product category.

4. Enter a quantity.

5. Enter an amount.

6. Enter a source name.

7. Click Add to add additional items.

You can remove purchase items by clicking the checkbox for an item and 
clicking Remove.

Adding Tasks

Steps
1. In the task window (for example, Create Lead, or Create Opportunity), click the 

Tasks tab. 

2. Click Create. The Create Tasks window appears. This window is detailed in 
Chapter 2, "Managing Tasks". The tasks that you create are listed in the Tasks 
tab.

Adding Notes

Steps
1. In the task window (for example, Create Task, or Create Lead), click the Notes 

tab. 

2. Select a note type.
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3. Select a note status.

4. Enter the note text.

5. Click Add Note. Notes that you add are posted in the upper part of the 
window. You can sort them by date or by type.
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Managing Tasks

Sections in this chapter include:

� Section 2.1, "Creating a Task"

� Section 2.2, "Updating a Task"

� Section 2.3, "Accessing the Daily Task Summary"

Use the Task tab to view, create and edit tasks. Tasks are your day-to-day activities 
related to customers, leads, and other sales-cycle events. Also, the Calendar button 
enables you to access a Daily Task summary, which lists your tasks occurring 
between specified start and end dates. 

The Task tab displays all of your tasks, or tasks that have been assigned to you.

2.1 Creating a Task

Steps
1. In the Task tab, click Create.

2. In the Task Details tab, select a task type.

3. Enter a task name.

4. Describe the task.

5. Set the Priority for the task.

6. Select a Status for the task.

Note:  Sales Offline does not support recurring tasks in this 
release. 
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7. Specify if the task should be private or requires notification.

8. Select a Category for the task.

9. Select start and end dates and times for the task, and specify if it is Planned, 
Scheduled, or Actual.

10. Select the customer type, if needed, and search for the customer’s name.

11. Click the References tab to add optional reference information to the task.

You may also remove any reference rows by selecting the associated remove 
checkbox and clicking Save or Apply. 

12. Click the Assignments tab to add optional assignees to a task.

You can add additional persons to assign the task. In the Assignments tab of the 
Task detail user from, click the Add an Assignment field and select the person 
to assign the task from the pull-down menu. Click Add.

Note: The task number is generated after synchronization.   

Note: The References tab in Sales Offline will not automatically 
populate reference rows. Upon syncing the newly created task, the 
reference rows will automatically be created in the online sales 
application, and the appropriate reference rows are synchronized to 
the Sales Offline task. You may add additional rows in Sales Offline 
if you choose to do so.

For example, if you select a contact, Brenda Johnson@ Business 
World, the references for the contact Brenda Johnson and 
organization Business World are automatically generated by the 
online applications after you synchronize. 
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You may also remove an assignment rows (except the "owner" row) by selecting 
the associated remove checkbox and clicking Save or Apply.

13. Click the Contacts tab to add optional contacts to a task. In the Contacts tab of 
the Create Task user window, place in the contacts name you wish to add, click 
Go, and select the contact from the list of values. In order to select the primary 
contact for a Task, select the primary radio button next to the contact you wish 
to mark as primary. 

You may remove any contact rows by selecting the associated remove checkbox 
and clicking Save or Apply. 

14. Click the Notes tab to create a note for the task.

15. Click Create to create the task. 

2.2 Updating a Task

Steps
To update an existing task:

1. In the Task tab, click the task name. The Task Details window opens. 

2. Complete any appropriate updates. 

Note: The Assignments tab in Sales Offline will not automatically 
populate any assignment rows. With the next synchronization, the, 
the assignment’s "owner" row for the new task is automatically 
created in the online sales application, and the "owner" row is 
synchronized to the Sales Offline task record. The "owner" of the 
task is the Sales Offline user who created the task. You may add 
additional assignee rows in Sales Offline if you choose to do so. 

Note: The contacts (party relationships) available in the Contacts 
tab depend on the information in the Customer Frame of the Task 
details tab. Only contacts associated (for example, which have 
relationships to the Organization) with the Organization in the 
Customer Frame is available in the Contacts tab.   
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3. Click Apply to apply changes as you continue to make changes, or click Save 
when you have completed your changes.

2.3 Accessing the Daily Task Summary
Click Calendar to access a Daily Task Summary. This summary displays all of the 
tasks that have a start date of a specified day, or within a date range. The task 
summary displays this task information:

� Task name

� Status

� Start date and end date
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Managing Leads

Sections in this chapter include:

� Section 3.1, "Creating a Lead"

� Section 3.2, "Updating a Lead"

� Section 3.3, "Lead to Opportunity Business Flow"

Use the Lead tab to view and manage leads. Leads are intended to capture the 
initial contact with potential customers, gathering information to indicate to a sales 
organization whether or not there is sufficient interest on the part of the buyer. 
When a lead is entered into the system, it can be ranked and assigned to the 
appropriate sales resource.

Once enough key information has been gathered, a lead can be qualified by a sales 
representative.

Leads can be generated through different sources:

� Marketing campaigns and trade shows can generate leads that can be imported 
into the system through the Lead Import process.

� TeleSales agents record lead information from phone calls into the system.

� Field Sales representatives record lead information from the field into a sales 
application.

You can perform the following functions from the lead tab:

� Create leads

� Update leads, which includes maintaining:

� Contacts

� Sales Teams
eads 3-1



Creating a Lead
� Purchase Items

� Notes

� Tasks

3.1 Creating a Lead

Steps
To create a lead:

1. In the Lead tab, click Create.

The Create Lead window opens. Certain fields will automatically populate 
based on data and profile preferences established in your Online Sales 
applications.

2. Select the Organization or Person radio button to list the organization name or 
the person’s name and address in the search results.

Enter a customer name or search for a customer. Place the appropriate customer 
name in the customer field, or enter part of a customer name and click Go. The 
list of customers will display. You can select a customer from this list, or search 
for another customer. 

Or, you can create a customer by clicking Create Customer.

An address is returned with the selected customer.

Select an address by clicking Add or Change next to the address field. A list of 
customer addresses displays in the Select an Address window. Click the radio 
button next to the appropriate address and click Select.

3. Enter a lead name.

4. Select a Primary Contact for the lead, or create a new contact by clicking New.

5. Select the Contact Role.

6. Specify whether the lead is Qualified and/or Urgent.

7. Add the Project name associated with this lead.

Note: There is Flexfield support for Header and Purchase Item 
level flexfields. If Flexfield functionality has been implemented for 
a lead, the Flexfield name, field, and Flexfield are displayed. 
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8. Select the Status of the lead.

9. Select the Lead Rank.

10. Select a Channel for the lead.

11. Select a Response Channel.

12. Select the Time Frame for the lead.

13. Select a Budget Status.

14. Enter the Budget amount.

15. Select Currency type.

16. Enter the Source Name for the lead, or search for the name by clicking Go.

17. Enter the Offer name, or search for the name by clicking Go.

18. Enter any flexfield information, if applicable. 

19. Click the Purchase Items tab to enter purchase item information.

20. Click the Notes tab to enter notes. 

21. Click Save to save the lead.

If needed, click Cancel to cancel creation of the lead.

3.2 Updating a Lead

Steps
To update an existing lead:

1. In the Lead tab, click the name of the lead. The Lead Details window opens.

2. Complete any appropriate updates.

3. Click the Opportunities tab to view any opportunities generated by the lead.

4. Click Save when you have completed your changes. 

If needed, click Cancel to cancel update of the lead.

3.3 Lead to Opportunity Business Flow
To create a opportunity from an lead:
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In the Lead Details window, click Lead to Opportunity. 

Certain information will flow from the lead to the new opportunity, in a new 
Opportunity Detail window. The lead information that will flow to the new 
opportunity is:

� Lead Name (Opportunity name)

� Customer Name

� Primary Contact

� Project

� Budget

� Currency

� Source (header level)

� Offer (header level)

� Address

� Lead Purchase Items (including quantity, amount, source, and offer)

� Sales Team

� Contacts
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Managing Opportunities

Sections in this chapter include:

� Section 4.1, "Creating an Opportunity"

� Section 4.2, "Updating an Opportunity"

� Section 4.3, "Opportunity to Quote Business Flow"

An opportunity is a potential sale. This process begins with the initial customer 
contact and ends when the sales representative makes or loses the sale.

You can perform the following functions from the opportunity tab:

� Create opportunities

� Update opportunities, which includes maintaining:

� Purchase Items

� Contacts

� Classifications

� Win/Loss

� Leads

� Sales Team

� Notes

� Tasks

Once opportunities are identified, you can perform the following tasks:

� Enter information on items to be purchased

� Track the likelihood of closing the sale
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� Allocate credit toward sales quotas after closing a sale

� Create a quote from the opportunity

� Add other issues (under the Win/Loss tab)

Sales representatives can manage existing opportunities, assigned to them manually 
or automatically through Territory Assignment, or they can enter new 
opportunities. 

By default, the sales representative who created the opportunity has full access to 
the opportunity. Full access to the opportunity means that the sales representative 
who created the opportunity can add other sales team members, assign sales 
credits, and rate the likelihood that the opportunity will succeed.

4.1 Creating an Opportunity
Complete the following steps to create an opportunity:

Steps
1. In the Opportunity tab, click Create.

The Create Opportunity window opens.

2. Select the Organization or Person radio button to list the organization name or 
the person’s name and address in the search results.

Enter a customer name or search for a customer. Enter the appropriate customer 
name in the Select a Customer field, or enter part of a customer name and click 
Go. The list of customers will display. You can select a customer from this list, or 
search for another customer. 

Or, you can create a customer by clicking Create Customer.

Select an address by clicking Add or Change next to the address field. A list of 
customer addresses displays in the Select an Address window. Click the radio 
button next to the appropriate address and click Select.

3. Enter an Opportunity Name.

4. Select a Primary Contact for the opportunity, or create a new contact by clicking 
New.

Note: There is Flexfield support for Header and Purchase Item 
levels. If Flexfield functionality has been implemented for an 
opportunity, the Flexfield name, field, and Flexfield button display. 
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5. Select the Contact Role.

6. Enter the Project Name.

7. Select the Status of the opportunity. 

8. Select the Sales Channel.

9. Select the Methodology associated with the opportunity. 

10. Select the Sales Stage for the opportunity.

11. Select the Win Probability.

12. Enter the Budget amount.

13. Enter the close date for the opportunity.

14. Specify the currency type.

15. Enter the Source Name for the opportunity, or search for the name by clicking 
Go.

16. Enter the Offer name, or search for the name by clicking Go.

17. Click the Purchase Items tab to enter purchase item information.

18. Click the Notes tab to enter notes. 

19. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values dynamically.

20. Click Save to save the opportunity.

If needed, click Cancel to cancel creation of the opportunity.

4.2 Updating an Opportunity

Steps
To update an existing opportunity:

1. In the Opportunity tab, click the name of the opportunity. The Opportunity 
Details window opens.

2. Complete any appropriate changes. 

3. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values dynamically.

4. Click Save when you have completed your changes.
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Opportunity to Quote Business Flow
If needed, click Cancel to cancel the update of an opportunity.

4.3 Opportunity to Quote Business Flow
To create a quote from an opportunity:

1. In the Opportunity Details window, click Create Quote to flow the opportunity 
information into a new quote. A new quote can be created based on certain 
information that flows from an existing opportunity. Only purchase item rows 
with a specified inventory item numbers (along with it’s associated quantity) 
are carried over to the new quote.

Certain information will flow from the opportunity to the new quote, into a 
new Create Quote window. The opportunity information that will go into the 
new quote (provided the information exists in the opportunity) is:

� Opportunity Name (flows to the Quote Name field)

� Customer Name

� Contact Name

� Sales Channel

� Opportunity Purchase Items (if they have specific inventory items on the 
purchase item line)

� Sales Team

� Address

2. Click Apply.
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Managing Quotes

Sections in this chapter include:

� Section 5.1, "Creating a Quote"

� Section 5.2, "Updating a Quote"

� Section 5.3, "Quote Approvals"

� Section 5.4, "Place Order"

A quote is the communication of pricing and discounts for a particular sale. When 
the customer is ready to order a particular product they are notified of this available 
pricing and discount information through a quote. 

You can perform the following functions from the quote tab:

� Create quotes

� Update quotes, which includes maintaining:

� Lines

� Addresses

� Sales Teams

� Sales Credits

� Approvals

Note: You must select specific items from the Profile: Sync 
Preferences: Quote tab to be used in the quoting module Only those 
items downloaded to Sales Offline can be used to add new 
products to the quote.
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Creating a Quote
� Notes

� Tasks

5.1 Creating a Quote

Steps
To create a quote:

1. In the Quote tab, click Create.

The Create Quote window opens.

2. Enter a Quote Name.

3. Select the Addresses or Contacts radio button to list the address or the contact 
information in the search results.

Enter a Customer name or search for a customer. Enter a keyword to search on, 
or the first three characters of a keyword and click Go. The list of customers will 
display. You can select a customer from this list, or search for another customer. 

4. Enter the Contact Name. Enter the appropriate contact name in the contact 
fields and click Go. The list of contacts will display. You can select a contact, or 
search for another contact. 

5. Enter the Expiration Date for the quote.

6. Select the Primary Salesperson.

7. Select the Sales Channel.

8. Select the Order Type.

9. Select the associated Agreement.

10. Select the Currency type.

11. Select a Price List.

12. Enter any flexfield information, if applicable

13. Click Apply to display additional tabs.

Note: There is Flexfield support for the Quote Header and Line 
levels. If Flexfield functionality has been implemented for a quote, 
the Flexfield name, field, and Flexfield button will display. 
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Updating a Quote
14. Click the Lines tab to add product lines, or to add a service to a product. Click 
Add New Product to search and select products for the quote. 

If you want to add a service item (for example, Warranty) to an existing product 
line, highlight the specific line by clicking the radio button associated with the 
product line, click Add Services, and search or select a service item to be 
attached to the product line. You will only be able to add service item lines for 
product lines are serviceable items.

15. Click the Addresses tab to add shipping and billing addresses, and manage 
payment terms. These addresses will default depending on the customer you 
entered when creating the quote.

16. Click the Sales Team tab to add new members to the sales team.

17. Click the Sales Credits tab to give credits for the appropriate sales 
representative.

18. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values dynamically.

19. Click Save to save the quote.

If needed, click Cancel to cancel the creation of the quote.

5.2 Updating a Quote

Steps
To update an existing quote:

1. In the Quote tab, click the name of the quote. The Quote Details window opens.

2. Click Apply to commit changes and calculate values. You can modify values 
and then click Apply to recalculate values dynamically.

3. Click Save when you have completed your changes.

If needed, click Cancel to cancel the update of the quote.

Note: After saving a Quote the Notes and Tasks tabs become 
available. 
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Quote Approvals
5.3 Quote Approvals
If you have approvals established for the Quoting application, the Initiate 
Approvals button will appear in the Approvals tab of the Quote Details window. If 
the status transition is to get an Approval, the user can hit the Initiate Approvals 
button for the approvals process to take place. The Quote must be synchronized for 
the approvals process to begin. No approval rows are displayed in the Approvals 
tab of the Sales Offline, Quote Details window. 

5.4 Place Order
The Place Order button will highlight on the Sales Offline, Quote Details window if 
the Place Order status transition is established in the Quoting application. 
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Managing Forecasts

Sections in this chapter include:

� Section 6.1, "Opportunity Worksheet"

� Section 6.2, "Product Category Worksheet"

� Section 6.3, "Generating Forecasts"

� Section 6.4, "Viewing and Submitting Forecasts"

Forecasting is a quantitative tool used to predict the amount of sales for a specified 
time period. Forecasting can be used by managers and sales team members to 
commit to the amount of sales that they will close by the end of the forecasting 
period. 

You will use worksheets to create forecasts. The worksheets are:

� Opportunity Worksheet: Opportunity-level forecasting provides a tool for sales 
representatives to use to create their own view of, and commitment to, sales 
opportunities for themselves and others on the sales team. Opportunity 
forecasting also gives sales representatives the ability to review, modify, and 
commit at a more detailed product category level. 

� Product Category Worksheet: Forecasting at the Product Category level 
provides sales representatives access to their pipeline aggregated into product 
groupings. They can then forecast their sales at the product level by rolling up 
opportunity lines into product groupings.

You can perform the following functions from the Forecast tab:

� Generate forecasts and submit forecasts

� View opportunity level worksheets

� View product category worksheets
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Opportunity Worksheet
� View generate forecast values

6.1 Opportunity Worksheet
Opportunity Level Forecasting provides a tool for sales team members to view their 
opportunities being forecasted. Worksheets are submitted with the generated 
forecasts chosen for submission.

Steps
To view opportunity worksheets:

1. From the Forecast tab, click the Opportunity subtab.

The Opportunity Worksheet window opens.

2. Select the Sales Group, for which you want to view forecast.

3. Select the Period Name.

4. Select one of the following options:

� Use Previously Saved Values: If you are forecasting for the first time, the 
value is based on the Oracle Field Sales profile preferences. If you have 
saved an opportunity worksheet, those values will default.

� Use Pipeline Default Values: This includes all deals available for 
forecasting whose close date falls within the current forecasting period. If 
you choose this option, the pipeline amounts for the period are populated 
into the worksheet. 

You can edit the forecast values by highlighting the cells (Worst Case, Forecast, 
Best Case) and adding the value. The forecast numbers will reflect the 
opportunity forecast data available in Sales Offline.

5. Click Save to save your Opportunity worksheet.

6.2 Product Category Worksheet
Forecasting at Product Category level gives sales team members an easy way to 
view their pipeline aggregated into product groupings. Worksheets are submitted 
with the generated forecasts chosen for submission.
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Generating Forecasts
6.2.1 Viewing Product Level Forecasts Using Product Category Worksheets

Steps
To view product level forecasts using product category worksheets:

1. From the Forecast tab, click the Product Category subtab.

The Product Category Worksheet window opens.

2. Select the Sales Group, for which you want to forecast.

3. Select the Period Name.

The forecast numbers will reflect the opportunity forecast data available in Sales 
Offline.

4. You can edit the forecast values by highlighting the Worst Case, Forecast, or 
Best Case cell and adding in the value.

Pipeline defaults use the following criteria:

� Worst Case: Total Won Amount = Sum of all won opportunities

� Forecast: Weighted pipeline = Weighted sum of open opportunity amount 
multiplied by their win probability

� Best Case: Total sum of all open opportunities

5. Click Save to save your Product Category worksheet.

6.3 Generating Forecasts
Under the Forecast tab, you will find the Generate Forecast subtab. Sales 
representatives can generate individual forecasts for multiple periods from this 
window. Forecasts are generated based on their current downloaded pipeline 
values. Users can forecast based on their default currency.

Steps
To generate a forecast:

1. From the Forecast tab, click the Generate Forecast subtab.

2. Select a sales group from the drop down list.

3. Select the “From Period” and “To Period”.

4. Click View.
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Viewing and Submitting Forecasts
The values generated for your forecast are displayed.

5. Select all periods for which you want to generate forecasts by selecting the 
check box.

The forecast is now ready to be submitted when you synchronize. Only the 
most recent submission is accepted. You cannot submit more than one forecast 
per synchronization. 

6. Click Submit.

6.4 Viewing and Submitting Forecasts

Steps
To view Forecasts:

1. From the Forecast tab, click the Forecast subtab.

2. Select the Sales Group.

3. Select the Period Name.

4. The forecast numbers will reflect the opportunity forecast data available in Sales 
Offline.

5. You can edit the forecast values by highlighting the Best Case, Forecast, or 
Worst Case cell and adding in the value.

6. Click Submit. 

The forecast is now ready to be submitted when you synchronize. Only the 
most recent submission is accepted. You can not submit more than one forecast 
per synchronization.
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Managing Customers

Sections in this chapter include:

� Section 7.1, "Organization Subtab"

� Section 7.1.1, "Creating a Customer - Organization"

� Section 7.1.2, "Updating a Customer - Organization"

� Section 7.2, "Contact Subtab"

� Section 7.2.1, "Creating a Customer - Contact"

� Section 7.2.2, "Updating a Customer - Contact"

� Section 7.3, "Person Subtab"

� Section 7.3.1, "Creating a Customer - Person"

� Section 7.4, "Updating a Customer - Person"

The Customer tab is comprised of three subtabs, Organization, Contact and 
Persons. By default, the Customer tab opens to the Organization window. Click the 
Contact subtab to open the Contact window, or the Persons subtab to open the 
Persons window. A person may be a contact for an organization. An Organization 
may have one or more contacts.

Use the Customer tab to create and maintain the following:

� Organizations

� Contacts
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Organization Subtab
� Persons

7.1 Organization Subtab
The Organization subtab displays:

� Organizations

� Customer Category

� Address

� Phone

� Organization

You can use the Organization subtab to perform the following tasks:

� Create organizations

� Maintain organization details

� Create and maintain address information

� Create notes

� Manage tasks

7.1.1 Creating a Customer - Organization 

Steps
To create an organization:

1.  In the Customer tab, Organization subtab, click Create. The Create 
Organization window opens. 

2. Enter the Organization name.

3. Enter the phonetic Pronunciation of the organization name.

4. Enter any Alias for the organization.

5. Enter the DUNS Number for the organization.

Note: There is Flexfield support for the customer module. If 
Flexfield functionality has been implemented for an organization or 
contact, the Flexfield name, field, and Flexfield button will display.
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Organization Subtab
6. Enter the Phone Number for the organization.

7. Enter the Tax ID for the organization.

8. Enter the Email Address for the organization.

9. Select the Customer Category.

10. Enter the Business Line for the organization.

11. Enter the Annual Revenue number for the organization.

12. Enter the Total Employees in the organization.

13. Select the Fiscal Year End for the organization.

14. Enter the Years Established.

15. Enter the URL for the organization’s Website.

16. Enter any flexfield information, if applicable.

17. Click the Addresses tab to manage addresses for the organization.

18. Click Create Address to add a new address. Enter the required fields (an 
address type) and click Save to save the address information. 

19. Click the Notes tab to enter notes.

20. Click Save to create a new organization.

If needed, click Cancel to cancel the customer information.

After you click Save, the Sales Team and Task tabs are available when you open 
the Organization Details.

7.1.2 Updating a Customer - Organization 

Steps
To update information for an organization:

1. In the Customer tab, Organization subtab, click the name of the organization.

2. Update any fields as needed.

3. Click the Addresses tab to add new addresses for the person.

4. Click the Sales Team tab to add or remove sales team members.

5. Click the Notes tab to enter notes.
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Contact Subtab
6. Click the Tasks tab to review tasks.

7. Click Save when you are done making changes.

If needed, click Cancel to cancel the update of the customer information.

7.2 Contact Subtab
The Contact summary page displays:

� Person name (hyperlinked to Person Details)

� Relationship (hyperlinked to Contact Details)

� Customer

� Phone

� Email

You can use the Contact subtab to perform the following tasks:

� Create a contact

� Maintain contact details

� Add and maintain contact address information

� Create notes

� Manage tasks

Click the Relationship link to view Contact Details; click the Person link to view 
Person Details.

7.2.1 Creating a Customer - Contact

Steps
To create a contact:

1. In the Customer tab, Contact subtab, click Create.

The Create Contact window opens.

2. Select a Contact. You can select an existing contact from the list of contact names 
in the Contact Name drop-down menu, or specify a new Contact name by 
clicking New.
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Contact Subtab
To create a new contact, click New. The Create Person window opens. See the 
Person Subtab for details. 

3. Click Save to create the new contact. The newly created contact is now available 
for you to add to an existing organization. 

4. Select Organization.

If the organization is new, click New next to the organization field to create new 
organization. Refer to Organization Subtab for details on creating an 
organization.

5. Select a Relationship Type.

6. Enter the Phone Number for the contact.

7. Enter the Email Address for the contact.

8. Enter the Department of the contact.

9. Select the Department type.

10. Enter the Job Title.

11. Select the Job Title Type for the contact.

12. Select the Preferred Language for the contact.

13. Specify if the contact is a Decision Maker or a Reference.

14. Enter any flexfield information, if applicable.

15. Click Add an Address in the Addresses tab to add new addresses for the 
contact. A list of addresses associated with the organization will appear. Choose 
an address and click Select. The Add a Relationship Address window appears 
allowing you to add address types.

16. Click the Notes tab to enter notes.

17. Click Save to create a new contact.

If needed, click Cancel to cancel the creation of the contact. 

7.2.2 Updating a Customer - Contact

Steps
To update information for a contact:
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Person Subtab
1. In the Customer tab, Contact subtab, click a contact name. The Contact Detail 
window opens.

2. Update any fields as needed. 

3. Click the Addresses tab to add new addresses for the person.

4. Click the Classifications tab to select a classification category and a classification 
status.

5. Click the Sales Team tab to add or remove sales team members.

6. Click the Notes tab to enter notes.

7. Click the Tasks tab to review tasks.

8. Click Save to commit your changes.

If needed, click Cancel to cancel the update of the contact.

7.3 Person Subtab
The Person summary page displays:

� Person name (hyperlinked to Person Details)

� Address

� Phone

� Email

You can use the Person subtab to perform the following tasks:

� Create a person

� Maintain person details

� Create and maintain product interests

� Create and maintain classifications address information

� Create and maintain notes

� Create and maintain sales team

� Create and maintain notes

Note: After saving a Customer update, the Tasks tab becomes 
available. 
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Updating a Customer - Person
7.3.1 Creating a Customer - Person

Steps
To create a person:

1. In the Customer tab, Person subtab, click Create.

The Create Person window opens.

2. Enter the person’s name. This includes last name, first name, preferred name, 
last and first name pronunciation, and middle name.

3. Enter any title and second title (if applicable).

4. Enter any suffix (such as Jr.).

5. Enter date of birth for the person.

6. Select a gender.

7. Select native language.

8. Enter phone number.

9. Enter E-mail address.

10. Select a status for the Person.

11. Enter any flexfield information, if applicable.

12. Click Create Address in the Addresses tab to add new addresses for the person. 
A list of addresses associated with the organization will appear. Choose an 
address and click Select. 

13. Click the Notes tab to enter notes.

14. Click Save to create a new person.

If needed, click Cancel to cancel the creation of the person. 

7.4 Updating a Customer - Person

Steps
To update information for a person:

Note: After saving a Person, the Product Interest, Classifications, 
Sales Team, and Tasks tabs become available. 
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Updating a Customer - Person
1. In the Customer tab, Person subtab, click a person name. The Person Detail 
window opens.

2. Enter Product Interests. 

3. Click the Addresses tab to add new addresses for the person.

4. Click the Classifications tab to select a classification category and a classification 
status.

5. Click the Sales Team tab to add or remove sales team members.

6. Click the Notes tab to enter notes.

7. Click the Tasks tab to review tasks.

8. Click Save to commit your changes.

If needed, click Cancel to cancel the update of the person.
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